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2. Fair Value Measurements
2.FAIR VALUE MEASUREMENTS

The fair value of an asset is considered to be the price at which the asset could be sold in an orderly transaction between
vnrelated knowledgeable and willing parties. A liability™s fair value is defined as the amount that would be paid to transfer the
liability to a new obligor, rather than the amount that would be paid to settle the liability with the creditor. Assets and liabilities
recorded at fair value are measured using a three-tier fair value hierarchy, which prioritizes the inputs used in measuring fair
value. These tiers include:

* Levell — Observable inputs that reflect quoted prices in active markets
* Level2 — Inputs other than quoted prices in active markets that are either directly or indirectly observable
* Level3 — Unobservable inputs in which little or no market data exists, therefore requiring the Company to

develop its own assumgptions

Assets and Liabilities Measured at Fair Value on a Recurring Basis

The assets and Habilities of the Company that are measured at fair value on a recurring basis as of Janvary 31, 2018 and
January 31, 2017 were as follows (amounts in millions):

Fair Value at June 30, 2015 Using Fair Value at June 30, 2014 Using

Level 1 Level 2 Level 3 Level L Level 2 Level 3
Derivative agreements - assets " — 5 82 s s — 5 77 s —
"Derivative agreements - liabilities P a7 "
¥ Total 5 s 8 % ss s

The Company uses derivative financial mstruments from time to time in the management of itz interest rate exposure on long-
term debt and its exposure on foreign currency fluctuations. The fair value of the Company’s derivative financial instruments
was measured using level 2 inputs. The Company’s derivative agreements are discussed further in Note 4. Income Taxes.

Assets and Liabilities Measured at Fair Value on a Nonrecurring Basis

The assets and labilities of the Company that were measured at fair value on a nonrecurring basis as of January 31, 2018 and
Januvary 31, 2017 were as follows (amounts in millions):

P Fair Value F
Measured During
Fiscal 43190 Level 3 Gains (Losses)
Teaze obligation costs, net 's (153) 's (26)
———
¥ Total for fiscal 43190 S (26)
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2. FAIR VALUE MEASUREMENTS

The fair value of an asset is considered to be the price at which the asset could be sold in an orderly transaction between
unrelated knowledgeable and willing parties. A liability’s fair value is defined as the amount that would be paid to transfer the
liability to a new obligor, rather than the amount that would be paid to settle the liability with the creditor. Assets and liabilities
recorded at fair value are measured using a three-tier fair value hierarchy, which prioritizes the inputs used in measuring fair
value. These tiers include:

* Levell — Observable inputs that reflect quoted prices in active markets
* Level2 — Inputs other than quoted prices in active markets that are either directly or indirectly observable
* Level3 — Unobservable inputs in which little or no market data exists, therefore requiring the Company to

develop its own assumptions

Assets and Liabilities Measured at Fair Value on a Recurring Basis

The assets and labilities of the Company that are measured at fair value on a recurring basis as of Janvary 31, 2018 and
January 31, 2017 were az follows (amounts in millions):

Fair Value at June 30, 2015 Using Fair Value at June 30, 2014 Using
Level 1 Level 2 Level 3 Level 1 Level 2 Level 3
—

Perivative agreements - assets 3 82 % 3 3 778
Derivative agreements - liabilities ¥ —|F (29) r —|F —|F (19) r —
¥ Totat Kk sk K K% s

The Company uses derivative financial instruments from time to time in the management of its interest rate exposure on long-
term debt and its exposure on foreign currency fluctuations. The fair value of the Company’s derivative financial instruments
was measured uzing level 2 inputs. The Company’s derivative agreements are discussed further in Note 4. Income Taxes.

Assets and Liabilities Measured at Fair Value on a Nonrecurring Basis

The assets and labilities of the Company that were measured at fair value on a nonrecusring basis as of January 31, 2018 and
January 31, 2017 were as follows (amounts in millions):

r r

Fair Value

Measured During
Fiscal 43190 Level 3

's 1s3) s

Gains (Losses)

L eaze obligation costs, net
¥ Total for fiscal 43190
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Line Spacing Single -
Fair Value at June 30, 2015 Using Fair Value at June 30, 2014 Using
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Derivative agreements - assets — K 52 5 — 5 — 5 7 s — Before 0 pts
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The Company uses derivative financial instruments from time to time in the management of its interest rate exposure on long-
term debt and its exposure on foreign currency fluctuations. The fair value of the Company’s derivative financial instruments
was measured using level 2 inputs. The Company’s derivative agreements are discussed further in Note 4. Income Taxes. (@ Pagination
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2. Fair Value Measurements
2.FAIR VALUE MEASUREMENTS

The fair value of an asset is considered to be the price at which the asset could be sold in an orderly transaction between
vnrelated knowledgeable and willing parties. A liability™s fair value is defined as the amount that would be paid to transfer the
liability to a new obligor, rather than the amount that would be paid to settle the liability with the creditor. Assets and liabilities
recorded at fair value are measured using a three-tier fair value hierarchy, which prioritizes the inputs used in measuring fair
value. These tiers include:

* Levell — Observable inputs that reflect quoted prices in active markets
* Level2 — Inputs other than quoted prices in active markets that are either directly or indirectly observable
* Level3 — Unobservable inputs in which little or no market data exists, therefore requiring the Company to

develop its own assumgptions

Assets and Liabilities Measured at Fair Value on a Recurring Basis

The assets and Habilities of the Company that are measured at fair value on a recurring basis as of Janvary 31, 2018 and
January 31, 2017 were as follows (amounts in millions):

Fair Value at June 30, 2015 Using Fair Value at June 30, 2014 Using

Level 1 Level 2 Level 3 Level L Level 2 Level 3
Derivative agreements - assets " — 5 82 s s — 5 77 s —
"Derivative agreements - liabilities P a7 "
¥ Total 5 s 8 % ss s

The Company uses derivative financial mstruments from time to time in the management of itz interest rate exposure on long-
term debt and its exposure on foreign currency fluctuations. The fair value of the Company’s derivative financial instruments
was measured using level 2 inputs. The Company’s derivative agreements are discussed further in Note 4. Income Taxes.

Assets and Liabilities Measured at Fair Value on a Nonrecurring Basis

The assets and labilities of the Company that were measured at fair value on a nonrecurring basis as of January 31, 2018 and
Januvary 31, 2017 were as follows (amounts in millions):

P FairVale
Measured During
Fiscal 43190 Level 3 Gains (Losses)
Teaze obligation costs, net 's (153) 's (26)
———
¥ Total for fiscal 43190 S (26)
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2. Fair Value Measurements
2.FAIR VALUE MEASUREMENTS

The fair value of an asset is considered to be the price at which the asset could be sold in an orderly transaction between
unrelated knowledgeable and willing parties. A liability’s fair value is defined as the amount that would be paid to transfer the
liability to a new obligor, rather than the amount that would be paid to settle the liability with the creditor. Assets and liabilities
recorded at fair valve are measured using a three-tier fair value hierarchy, which prioritizes the inputs used in measuring fair
value. These tiers include:

* Levell -
» Level2 -

* Level3 -

Ohbservable inputs that reflect quoted prices in active markets
Inputs other than quoted prices i active markets that are either directly or indirectly observable

Uncbservable inputs in which little or no market data exists, therefore requiring the Company to
develop its own assumptions

Display

Assets and Liabilities Measured at Fair Value on a Recurring Basis

The assets and hiabilities of the Company that are measured at fair value on a recurring basis as of Janvary 3
January 31, 2017 were az follows (amounts in millions):
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The Company uses derivative financial instruments from time to time in the management of its interest rate exposure on long-
term debt and its exposure on foreign currency fluctuations. The fair value of the Company’s derivative financial instruments
was measured using level 2 inputs. The Company’s derivative agreements are discussed further in Note 4. Income Taxes.

Assets and Liabilities Measured at Fair Value on a Nonrecurring Basis

The assets and liabilities of the Company that were measured at fair value on a nonrecurring basis as of January 31, 2018 and
January 31, 2017 were as follows (amounts in millions):
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2. FAIR VALUE MEASUREMENTS

The fair value of an asset is considerad to be the price at which the asset could be sold in an orderly transaction between
unrelated knowledgeable and willing parties. A liability’s fair value is defined as the amount that would be paid to transfer the
liability to a new obligor. rather than the amount that would be paid to settle the Liability with the creditor. Assets and hiabilities
recorded at fair value are measured using a three-tier fair value lerarchy, which prioritizes the mnputs used in measuring fair
value. These tiers include:

* Levell — Observable inputs that reflect quoted prices in active markets
* Level2 - Inputs other than quoted prices in active markets that are either directly or indirectly observable
» Level3 - Unobservable inputs in which little or no market data exists, therefore requiring the Company to

develop its own assumptions

Assets and Liabilities Measured at Fair Value on a Recurring Basis

The assets and liabilities of the Company that are measured at fair value on a recurring basis as of January 31, 2018 and
Tarmarv 31 2017 were as follows (amonnts in miTlions)-
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The File/Edit Tab - Activity

1. In the document you created
a. Go to Document Properties

Update Symbol Align to $(1,234.12)
Update page margins to Top ".75"

b. Go to Permissions

Filter by Owner
Add someone else in the class as viewer

c. From the Edit tab

Insert a Table

Your Turn!
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Formatting
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Adding Text - Activity

1. Rename Section 1 to "Table of Contents"
2. Add 2 new sections to the document outline
3. Rename the sections each:

a. "Overview"

b. "Performance”

Your Turn!

* Open the Wdesk doc called "Source Information - Copy/Paste" and copy text from there

4. Copy/paste Overview text* into Overview section
5. Copy/paste Performance text* into Performance section




Document Basics - Formatting

Formatting Your Text
e Style guides
e Format painter
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e Formatting
o Style Guides

(e]

Format Painter

Demo




Style Guides - Formatting Text - Activity Your Turn!

1. From the Styles drop down select "Edit Style Guide"

a. Normal
i. Change and lock the font style to "Calibri"
ii. Update Notes to "Calibri only"
b. Headings
i. Heading 1: Change Heading 1 to the color purple
ii. Heading 2: lock the font size and ltalicize
2. Publish your updates & return to Document
3. Apply Heading 1 style to the two headings in your document
4. Apply Heading 2 style to 2 Sub-titles in the "Performance" section
5. Go back to the still open "Style Guides" Tab
a. Update Heading 1 color to Green & Publish

Did all the headers in your document change to the color green?



Format Painter - Formatting Text - Activity Your Turn!

1. In the Overview Section
a. Pick some text from the first paragraph - bold it and format
it in a different color
2. Highlight that text
3. Double-click on the format Painter
4. Apply that formatting to other pieces of text in the next
paragraph

Note: Hit the Esc key or click the formatting painter button again to exit out of this
mode.



Milestone the Document - Activity Your Turn!

1. From the Right Hand Panel:
a. From the History panel
b. In the drop down menu for your most recent 5 minutes logged
c. Select > Create Milestone
i. Name: Draft 1
ii. Remarks: Text Formatting



Document Basics - Tables

Working With Tables
e Tables function much like mini spreadsheets
e Several additional formatting options appear on the toolbar when a table is activated
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"Source Information - Copy/Paste"

March 31,
{in thousands) 2015

Gross Income 12500 3

100.00 100.00
3 25.00, § 20.00
20.0 % -




When You Get Done Your Table Should Look
Something Like This:

YTD
March 31, March 31,
(in thousands) 2019 2018
Gross Income S 125.00 S 120.00
Expenses 100.00 100.00
Net Income S 25.00 S 20.00
% Profit 20.0 % 16.7 %
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Document Basics - Hyperlinking & Autotext

Hyperlinks & Autotext
e Easily hyperlink to:
o other sections within the same document
o other Wdesk documents
o external url
e Set page numbers to auto-update

Note: Need to ctrl+click to follow the hyperlink
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Hyperlinks & Auto-Text - Activity Your Turn!

1. Demote the Overview & Performance sections underneath of the
Table of Contents section
2. From "Source Information - Copy/Paste"
a. Copy table contents from "Hyperlinks & Auto-text" table into your
Table of Contents blank table
3. Apply a hyperlink to the Overview and Performance titles in the table
(hyperlinking to respective section in your document)
4. Replace page numbers with auto-text
a. Double-click into the cell needing a page number
b. From Edit>Insert>Auto-Text>Section Page Number
c. Select the corresponding Section and Insert



Documents
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